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Chapter 1
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1.1 MIA Main

Mass Icon Alter

Legal Matters

Installation
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How to Use MIA

Registering MIA

Index
NOTE: This document can be accessed from MIA by pressing the ←↩

help key.
Furthermore, if the mouse pointer is over a gadget when the help key is
pressed, then this document will be opened to the page that describes
that gadget.
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1.3 MIA ABOUT MIA

ABOUT MIA

Displays MIA version information, copyright information, creator’s
address, shareware notice, how to access this help guide (via ’Help’ key),
and to whom this copy of MIA is registered.

1.4 MIA APPEND TOOL TYPES

APPEND TOOL TYPES (Append T. Types)

NOT CHECKED

Replace destination icon’s Tool Types with those listed in MIA.
This means all of the destination icon’s Tool Types get erased.

Also, when dropping an icon into the MIA Tool Types gadget, all MIA
Tool Types are replaced by the Tool Types of the icon just
dropped.

CHECKED

Append the Tool Types in MIA to the destination icon’s Tool
Types. This means none of the destination icon’s Tool Types
get erased.

Also, when dropping an icon into the MIA Tool Types gadget, the icon’s
Tool Types are appended to the MIA Tool Types.

NOTE: MIA prevents duplicate Tool Types entries from being present when
appending Tool Types. This means that when Append T. Types is checked,
a new Tool Type replaces an old Tool Types of the same name. For example,
suppose MIA contains the Tool Type "SECONDS=20", and the icon to be
altered contains "SECONDS=10". When MIA is run on the icon, all of
MIA’s Tool Types are appended to the icon’s Tool Types except for
"SECONDS=20" which replaces "SECONDS=10".

1.5 MIA APPLICATION ICON
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APPLICATION ICON

MIA can run as an Application Icon which means that an icon will appear on
your Workbench screen that represents the MIA program. (NOTE: You can
change the appearance of this icon if you desire. See "def_AppIcon" in
the

What Happens During Installation
section.) See

Running MIA via Application Icon
for how to operate MIA while it is an

Application Icon.

When you no longer want to run MIA as an Application Icon, you must open
the MIA window and either choose to run MIA as an Application Menu Item or
quit MIA with the window close gadget.

1.6 MIA APPLICATION MENU ITEM

APPLICATION MENU ITEM

MIA can run as an Application Menu Item which means that a menu item will
appear on Workbench’s "Tools" menu that represents the MIA program. See

Running MIA via Application Menu Item
for how to operate MIA while it is an

Application Menu Item.

When you no longer want to run MIA as an Application Menu Item, you must
open the MIA window and either choose to run MIA as an Application Icon or
quit MIA with the window close gadget.

1.7 MIA BOTH IMAGES

BOTH IMAGES

This option applies to the two images displayed in the MIA window. The
image on the left is the "selected" icon image while the image on the
right is the "NON-selected" icon image. This option is only changeable
when the "Icon Imagery" box is checked.
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NOT CHECKED

When altering icons, only the selected image will be used. This means
icons with only one image are created. (The icons will use the
"complement" highlighting method.)

Also, when dropping icons on the MIA icon image areas, only the selected
image is copied to the area you drop the icon on. You can have the
NON-selected image copied by holding either of the "Alt" keys down while
dropping an icon over the image area.

CHECKED

When altering icons, both the selected and NON-selected images will be
copied. This means icons with two images are created. (The icons will
use the "image" highlighting method.)

Also, when dropping icons on the MIA icon image areas, both the selected
and NON-selected images are copied. The selected image is copied to
the area image you drop the icon on while the NON-selected image is
copied to the other icon area. You can have these reversed by holding
either of the "Alt" keys down while dropping an icon over the an image
area.

Note: MIA will NOT allow you to enter a NULL image (no image). If for
instance you drop an icon that only has one image and the Both Images box
is checked, then MIA will copy the icon’s image to the image area you
dropped it on, but the other image area will NOT be cleared and MIA will
beep/flash to let you know a NULL image was supplied.

MIA will also ignore icon images that are larger than the limits stated
in the Amiga User Interface Style Guide, Third Edition (page 90). MIA
will beep/flash if you try to supply an icon that is too big.

1.8 MIA CANCEL

CANCEL

Quit MIA without saving any changes.

1.9 MIA COMMENT

COMMENT
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When the "File Comment" action button is checked, whatever is in this
string gadget will be written as the comment for the files you alter.

NOTE: You may enter a comment by dropping an icon on this gadget.

1.10 MIA COPY DEFAULT TOOL

DEFAULT TOOL (Action command)

When this box is checked, whatever is in the "Default Tool" string gadget
will be written to the default tool attribute of the icons you alter.

1.11 MIA COPY FILE ATTRIBUTES

FILE ATTRIBUTES (Action command)

When this box is checked, the file attributes of the file(s) you modify
will be set the same as MIA’s file attribute check boxes to the left of
this gadget.

1.12 MIA FILE COMMENT

FILE COMMENT

When this box is checked, MIA will set the file comment of the file(s) to
be altered to the string from MIA’s "Comment" gadget.

1.13 MIA FILE DATE

FILE DATE

When this box is checked, MIA will set the date and time stamp of the
file(s) to be altered to that of MIA’s "Date" and "Time" gadgets.
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1.14 MIA ICON IMAGERY

ICON IMAGERY

When this box is checked, MIA will copy its images to the icon(s) to be
altered. MIA will look at the "Both Images" check box to determine how
the images are copied. See the

Both Images
section for how "Both Images"

affects "Icon Imagery".

NOTE: This feature is disabled in unregistered versions of MIA and will
display the "Mass Icon Alter Information" requester instead. If you would
like to use this feature, please register. Information for registering can
be found in the

Registering MIA
section.

1.15 MIA ICON TYPE

ICON TYPE

When this box is checked, MIA will change the type of the
icon(s) to be altered to what MIA’s "Type" gadget displays.

NOTE: You may change the type by dropping an icon on this gadget.

1.16 MIA STACK SIZE

STACK SIZE

When this box is checked, MIA will set an icon’s stack size field to the
value contained in MIA’s "Stack" gadget.

1.17 MIA COPY TOOL TYPES

TOOL TYPES (Action command)

When this box is checked, MIA will copy its Tool Types from its
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"Tool Types" gadget to the icon(s) to be altered. The "Append T. Types"
check box affects how MIA will copy Tool Types. See the

Append Tool Types
section for more details on how "Append T. Types" affects the ←↩

"Tool Types"
action command.

NOTE: This feature is disabled in unregistered versions of MIA and will
display the "Mass Icon Alter Information" requester instead. If you would
like to use this feature, please register. Information for registering can
be found in the

Registering MIA
section.

1.18 MIA CREATE ICONS

CREATE ICONS

When this box is checked, MIA will create icons for files that it alters
which do not have an associated icon.

1.19 MIA DATE

DATE

When the "File Date" action command is checked, this gadget’s contents
will be used for the new date stamp. The format for date entry is
dd-mmm-yy, where dd is day, mmm is month, and yy is year. For example,
01-May-94.

NOTE: You may have the date and time entered by dropping an icon on
either the "Date" or "Time" gadgets.

1.20 MIA DEFAULT TOOL

DEFAULT TOOL

When the "Default Tool" action command box is checked, this gadget’s
contents will be copied to the icon(s) being altered.
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NOTE: You may enter a default tool by dropping an icon on the gadget.

1.21 MIA DELETE

DELETE

When this button is clicked, the currently selected Tool Type will be
removed from the "Tool Types" gadget.

1.22 MIA FILE ATTRIBUTES

FILE ATTRIBUTES

When the "File Attributes" action command is checked, the file being
altered will have its protection bits set according to MIA’s file
attribute check boxes. When an MIA file attribute box is checked, then
that attribute will be set, otherwise it will be cleared. See the

File Attributes
section for the meaning of the bits.

NOTE: You may set file attributes by dropping an icon on them.

1.23 MIA MAKE DEFAULT

MAKE DEFAULT

When you click on this button, you are telling MIA that you want to make
the current MIA icon the default for the current icon type. The
current icon type is displayed in the "Type" icon gadget. MIA
will ask you to verify that you want to make the current icon the default
or will warn you if the default has already been replaced. By using
MIA’s "Modify a System Default Icon" requester, you can replace or delete
the current default for most icon types. Note that the replaced default
WILL survive a reboot.

NOTE: This feature is disabled in unregistered versions of MIA and will
display the "Mass Icon Alter Information" requester instead. If you would
like to use this feature, please register. Information for registering can
be found in the

Registering MIA
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section.

1.24 MIA NEW

NEW

By clicking on this gadget, you will be allowed to enter a new Tool Type
in the "Tool Types" gadget".

NOTE: You may also enter Tool Types by dropping an icon on the
"Tool Types" icon.

1.25 MIA NONS IMAGE

NON SELECTED IMAGE

This image will be copied to icons when the "Icon Imagery" box is checked,
and the "Both Images" icon is also checked.

NOTE: You may enter any valid image into this area by dropping an icon
in this box. See the

Icon Attributes
and
Both Images
sections for more

details.

1.26 MIA SAVE

SAVE

Whenever you click on this gadget, MIA saves all of the current settings
and action commands. If MIA is currently an Application Icon or Menu
Item, then after saving, MIA will return to being an Application Icon or
Menu Item, otherwise MIA will quit after saving.

NOTE: MIA also saves when you click on "AppIcon" or "AppMenuItem".
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1.27 MIA STACK

STACK

Whenever the "Stack Size" action command box is checked, the value
contained in this gadget will be copied to icon(s) being altered.

NOTE: You may enter a stack size by dropping an icon on this gadget.

1.28 MIA S IMAGE

SELECTED IMAGE

This image will be copied to icons when the "Icon Imagery" box is checked,
regardless of the setting of the "Both Images" box.

NOTE: You may enter any valid image into this area by dropping an icon
in this box. See the

Icon Attributes
and
Both Images
sections for more

details.

1.29 MIA TIME

TIME

When the "File Date" action command is checked, this gadget’s contents
will be used for the new date stamp. The format for time entry is
hh-mm-ss, where hh is hours, mm is minutes, and ss is seconds. For example,
07-59-45.

NOTE: You may have the date and time entered by dropping an icon on either
the "Date" or "Time" gadgets.

1.30 MIA TOOL STRING
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TOOL STRING

This gadget is used to edit the Tool Types in the "Tool Types" gadget.
This gadget is unghosted when you click on the "New" gadget, or select
a Tool Type from the "Tool Types" gadget.

1.31 MIA TOOL TYPES

TOOL TYPES

Whenever the "Tool Types" action command box is checked, the Tool Types in
this gadget will be copied to the icon(s) being altered. MIA looks at
the setting for the "Append T. Types" check box to determine how Tool
Types are copied. (Either replace or append) See the

Append Tool Types
section for more details.

To enter Tool Types, the "Tool Types" action command box must be checked,
and then you must click on the "New" gadget. Tool Types can be deleted by
clicking on a Tool Type in the "Tool Types" gadget and then clicking
the "Del" gadget.

NOTE: Tool Types may be entered by dropping an icon onto the "Tool Types"
icon. The setting of "Append T. Types" also applies to dropping the
icon into the "Tool Types" gadget.

1.32 MIA TYPE

TYPE

Whenever the "Icon Type" gadget is checked, icon(s) being altered will
be changed to the type displayed in this gadget. See the

Icon Attributes
sections for more details.

This gadget is also used to tell MIA which type of icon you want to
create a default icon for. See the

Make Default
section

for more details.
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NOTE: You may enter a type by dropping an icon on this gadget.

1.33 MIA Legal Matters

LEGAL MATTERS

AmigaGuide

Installer

MIA

1.34 MIA Legal Matters -- MIA

MIA

Mass Icon Alter (MIA), its support files, and this document are
all (c) Copyright 1994 by Boyd Edmondson, with All Rights Reserved,
unless explicitly stated otherwise.

All files are provided "as-is", and Boyd Edmondson is NOT responsible
in any way for any data manipulated by the MIA files nor any
devices which MIA may be operated on or have access to.

1.35 MIA Legal Matters -- Installer

INSTALLER

Installer and Installer project icon
(c) Copyright 1991-93 Commodore-Amiga, Inc. All Rights Reserved.
Reproduced and distributed under license from Commodore.

INSTALLER SOFTWARE IS PROVIDED "AS-IS" AND SUBJECT TO CHANGE;
NO WARRANTIES ARE MADE. ALL USE IS AT YOUR OWN RISK. NO LIABILITY
OR RESPONSIBILITY IS ASSUMED.
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1.36 MIA Legal Matters -- AmigaGuide

AMIGAGUIDE

AmigaGuide, AmigaGuide.info, amigaguide.library, WDisplay, WDisplay.info
(c) Copyright 1991-93 Commodore-Amiga, Inc. All Rights Reserved.
Reproduced and distributed under license from Commodore.

AMIGAGUIDE SOFTWARE IS PROVIDED "AS-IS" AND SUBJECT TO CHANGE;
NO WARRANTIES ARE MADE. ALL USE IS AT YOUR OWN RISK. NO LIABILITY
OR RESPONSIBILITY IS ASSUMED.

1.37 MIA Installation

INSTALLATION

Requirements

How to Install MIA

What Happens During Installation

1.38 MIA Requirements

REQUIREMENTS

To run MIA you need the following:

- Workbench 2.0 or better
- roughly 100K of RAM space (maximum)
- roughly 150K of disk space (maximum)

1.39 MIA What Happens During Installation

WHAT HAPPENS DURING INSTALLATION

Your installation can vary slightly on how you answer the questions when
running "Install-MIA", but basically what happens is as follows:

A drawer called "MIA" will be created and MIA and its support files
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will be copied into it. A new drawer also called "MIA" will be created
in your ENVARC: (and ENV:) directory. This drawer will contain private
information that MIA needs to operate. You should NOT modify these
files, except for possibly one. The "def_AppIcon" icon file CAN
be replaced by any icon you wish, just keep the name the same. When
MIA is put in AppIcon mode, it reads this icon image and uses it for
the MIA application icon image on your Workbench screen. You can
replace this icon image with whatever looks pleasing to you and your
Workbench setup. It can be altered with IconEdit or even MIA itself.

The MIA installer also gives you the opportunity to add a few
lines to your s:user-startup file. If you verify, in Install-MIA, that
it is ok to write to your user-startup, then an assignment and a path
will be added to your script. This will allow you to type ’mia’ at
any shell prompt and have MIA run. MIA will also use the assignment
MIA: when trying to access this help guide. (When MIA is running, you
can place your mouse pointer over a gadget and hit the ’Help’ key to
bring up this AmigaGuide document at the place that talks about that
gadget.)

1.40 MIA How to Install MIA

HOW TO INSTALL MIA

Simple. Just double-click on the "Install-MIA" icon and follow the
instructions.

1.41 MIA What MIA Does

WHAT MIA DOES

What does MIA do? Well, like the name implies ("Mass Icon Alter"), MIA
allows you to alter or change your icons on a group basis -- or change
a single icon if you want. MIA is designed to let you alter nearly every
attribute of an icon. If you have ever used Workbench’s Icon>Information
menu item, then you already know many of the features of an icon. You
may notice that MIA closely resembles Workbench’s icon information
requester. This is no mistake. MIA is designed to closely resemble that
requester because MIA has the same features, and more!

Before MIA, whenever you wanted to change one of your icons you had to select
the icon and then the information menu item from Workbench. After you
changed the values to what you wanted, you then clicked on the save gadget
in the information requester to update your icon. This is fine, but what
happens when you have 3, 10, or worse yet, a whole directory of icons that
you need to change? It would take a long time to select and change
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each icon individually.

This is where MIA comes in! You can run MIA and set the desired values
of icon attributes and then apply the changes to a whole group of icons.
See the section,

How to Use MIA
, on how to do this.

Like Workbench’s information requester, MIA allows changes of both an
icon and the file the icon represents. Whenever you see an icon from
Workbench, then that is a ".info" file which represents another file.
For example, suppose you have a program called "Test" that you can see
in a Workbench drawer window. You can see this because there is a
file called "Test.info" that Workbench reads from the disk and knows that
this ".info" file (or icon file) represents the program "Test". You can
alter both the "Test" file and the "Test.info" file. If you used
Workbench’s "System:Tools/IconEdit" program to change the image of the
Test icon, then you have changed the "Test.info" file. If you go to a
shell and type "filenote Test IamaFileComment", then you have changed
the "Test" file. (Type "list" to see the comment "IamaFileComment" or
use the information requester and look in the Comment gadget.)

For most users, it may not be necessary to know or care which one of the
files ("Test" or "Test.info") actually gets changed. For advanced users,
it may be very important to know which file gets changed. For this reason
the follow list is separated into two sections. One lists all the ICON
attributes that MIA allows you to manipulate, and the other lists the
FILE attributes that you may manipulate. See the

Examples
section

for how to change these attributes using MIA. You may also find
it advantageous to consult your Workbench user’s guide that came with
your Amiga to learn about the different types of icons, tool types, file
attributes, IconEdit, icons in general, etc.

Icon Attributes

File Attributes
MIA also gives you the following features:

Create Icons - When you tell MIA to manipulate a file, MIA must read the
file’s ".info" (or icon file) in order to make changes
to it. If the file does NOT have an icon file, then
MIA considers this an error. MIA will look to see if
you have checked the "Create Icons" check box. If it is
checked, then MIA will create a default icon for this file
and then apply your requested changes to it.

Make Default - As mentioned above, MIA may create a default icon when
necessary. Other programs may need to do the same thing.
Workbench, for example, creates default icons when you
select the "Window>Show> All Files" menu item. MIA allows
you to change these default icons. You may change these
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default icons just as you would any other icon.

1.42 MIA Change File Attributes

FILE ATTRIBUTES

The following is a list of all the FILE attributes that MIA allows you to
manipulate. (This means the ’main’ file is what gets changed, like
"Test" in the explanation used in

What MIA Does
.) The attributes are listed

and then a brief description is given about what each attribute means.
NOTE: While these attributes are listed separately, they are changed
by the same means as the other attributes.

Comment - A file can have a comment associated with it. You may
have used AmigaDOS’s "FileNote" program to change a
file’s comment or AmigaDOS’s "List" program to see
a file’s comment. MIA allows you to change file
comments.

Date and Time - AmigaDOS maintains a date and time ’stamp’ for each
file. This information can be useful to determine
if a file has been changed or if it is newer than
another file with the same name in another drawer.
MIA allows you to change files’ date and time stamps.

File Attributes - File attributes are used to determine what type a file
is and what may be done to it. You may want to consult
your AmigaDOS user’s guide book that came with your
Amiga to learn about the "Protect" command and file
attribute bits. The following file attributes can be
manipulated with MIA:

Script - Lets AmigaDOS know that this file is
a script file and that it should be
executed as an AmigaDOS command file
instead of running as a tool.

Archived - This bit can be utilized by backup
programs. If this file attribute bit
is set, then the backup program knows
that this file has already been
stored (or archived) in a previous
backup.

Readable - This attribute specifies if a file
can be read or not. For example, if
you set a document file UNreadable,
then your word processor would NOT be
able to load it any longer.
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Writable - This attribute tells AmigaDOS whether
or not it can alter this file. For
instance, if you set a document file
to UNwritable, then your word
processor would NOT be able to save
any of your changes back to that file.

Executable - This attribute lets AmigaDOS know that
this file is a tool that should be
run when activated. For example, if
you set your word processor to
UNexecutable, then the next time you
double-clicked on its icon the word
processor would NOT be able to run.

Deletable - This attribute lets AmigaDOS know that
this file can be deleted. For instance ←↩

,
If you set a file to UNdeletable, then
if you try to delete it, Workbench or
AmigaDOS would tell you that they could
NOT delete the file.

1.43 MIA Icon Attributes

ICON ATTRIBUTES

The following is a list of all the ICON attributes that MIA allows you to
manipulate. (This means the ".info" file is what gets changed, like
"Test.info" in the explanation used in

What MIA Does
.) The attributes are

listed and then a brief description is given about what each attribute means.

Default Tool

When you double-click on an icon (applies to Volume and Project icons
only), Workbench reads the ’Default Tool’ value of the icon and then
tries to run the program listed as the ’Default Tool’. For example,
many of the "Read.Me" files that you see run "System:More" when you
click on them. These icons have "More" as their default tool. If you
have Workbench 3.0, then you could replace the ’Default Tool’ fields
of all those "Read.Me" files to "System:Utilities/MultiView" so when
you double-click on them, they would run "MultiView" instead of "More".

Non-Selected Image

The ’Non-Selected Image’ is what the icon looks like on Workbench
BEFORE you click on it. You may have used Workbench’s "IconEdit"
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program to change the images for an icon. MIA is not designed to
allow you to draw icon images (use IconEdit for that), but it is
designed to let you replace icon images. You can have MIA replace
the non-selected image for any icon. MIA also allows you to change
an icon’s selected image. See ’Selected Image’ below.

Selected Image

The ’Selected Image’ is what the icon looks like on Workbench AFTER
you click on it. Note that some icons do NOT have a selected image.
These icons just complement the colors of the non-selected icon image.
MIA allows you to replace an icon’s selected image or give an icon
a selected image if it does not have one. You can even remove an
icon’s selected image and make it use complement mode instead.

Stack

When you double-click on an icon (applies to Tool and Project icons
only), then Workbench will read the ’Stack’ field of the icon to
determine what size of stack (in bytes) to allocate for the program
to run on. It may be important to note that when a program is run
via a project icon (like double-clicking a "Read.Me" file runs the
"More" program) that Workbench reads the PROJECT icon’s stack field
and NOT the tool icon’s. For instance, suppose you set the stack field
of the "Read.Me" file to 4096 and "More" had its stack field set to
8192. If you double-clicked on the "Read.Me" file, then "More" would
be run with a stack of 4096. If you double-clicked on "More" directly
then it would be run with a stack of 8192.

Tool Types

’Tool Types’ allow programs to receive parameters when run via
Workbench. For example, when icons are placed in the System:WBStartup
drawer, Workbench will automatically run those programs when you turn
on your Amiga. Before Workbench runs one of these programs it reads
the program’s icon’s tool types. If it finds a tool type it
understands, then it will act upon it. An example is the "DONOTWAIT"
tool type. If Workbench finds the DONOTWAIT tool type in the
icon, then Workbench knows that it should NOT wait for the program
to finish executing before running the next program in the WBStartup
drawer.

Other programs may also read tool types. For example, like many
programs, IconEdit supports a tool type called "LEFTEDGE=<n>" where
’<n>’ is replaced by some number like ’20’. When IconEdit runs, it
reads its icon’s Tool Types and looks for, among others, LEFTEDGE.
If it finds LEFTEDGE, then it reads the number assigned to it, like
20. IconEdit now knows that the user likes to have the IconEdit
window open 20 pixels from the left edge of the screen.

MIA allows you to manipulate tool types like those listed above. With
MIA you have the following options with tool types:
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- Remove all tool types from an icon
- Replace all tool types with new tool types
- Append new tool types to an icon’s tool types (this means

keep the old tool types AND add your new ones)
- Replace specific tool types (like replacing all tool types that

say ’LEFTEDGE=0’ with ’LEFTEDGE=20’)

Type

There are several ’types’ of icons. You may want to consult your
Workbench book supplied with your Amiga to learn more about each type
of icon, but here is quick reminder:

Drawer - "System:WBStartup" is an example of a ’Drawer’ icon.
When you double-click on a drawer icon a new window
opens which may contain more icons.

Project - Files found in the "System:Prefs/Presets" drawer are
examples of ’Project’ icons. When you double-click
a project icon the program listed as its ’Default-Tool’
is run first and then told to load the project file
you just clicked on. For example, if you double-click
on a document you created with a word processor, then
the word processor is run and then told to load the
document for you to edit.

Tool - Files found in the "System:Tools" drawer are examples
of ’Tool’ icons. When you double-click on a tool icon,
the file it represents is run. For instance, when you
double-click on IconEdit the IconEdit program runs.
In the example given above in ’Project’ the word
processor is a ’Tool’.

Trashcan - An example of a ’Trashcan’ icon can be seen when you
format a disk from Workbench. The format requester
has a check box gadget that is labeled ’Put Trashcan’.
When it is checked, a trashcan is put on the disk being
formatted. A trashcan is basically a ’Drawer’ icon that
is restricted from being moved out of the window it
resides in. Try grabbing a trashcan and dropping it
in another window. Workbench beeps you and states
something like "’Trashcan’ cannot be moved out of its
window".

Volume - The "System" disk icon is an example of a ’Volume’.
A volume is basically the highest level ’Drawer’ that
contains all other drawers on any given disk. It is
usually thought of as a disk or hard drive.

MIA allows you to alter the above mentioned types for icons. CAUTION:
IT COULD BE DANGEROUS TO CHANGE THE TYPE OF AN ICON. (Well, not really
that dangerous because you can always change the icon’s type back to
what it was.) There could be a problem if you do not understand the
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icon types as explained above, and therefore did not know what to change
the icon back to. For example, if you change a tool icon to say a
drawer icon, then you would no longer be able to run your program by
double-clicking on it.

You may be asking why you would even want to change an icon’s type.
Here is an example why you may want to do so.

Altering Icon Type

1.44 MIA How to Use MIA

HOW TO USE MIA

You can use MIA from either Workbench or from a Command Line Interface, but
the general usage remains the same. MIA retains state information in
the ENV: and ENVARC: directories. When you make attribute and action
changes, they are stored to these directories. When you activate MIA on
a file, the information last saved is applied to the file. This means
the general procedure for using MIA is as follows:

- Run MIA
- Modify ICON and FILE attributes
- Specify MIA actions
- Save (implicitly or explicitly)
- Run MIA on file(s) you want to modify

For example, double-click on the MIA icon. The MIA window now appears
on the screen. Select the "File Comment" check box. The "Comment" gadget
now becomes UNghosted. This means the gadget is capable of accepting input.
Now type "This is a file comment" into the comment gadget. We have
told MIA that we want to change file comments (by placing a check in the
"File Comment" check box) and that we want the file comment to be "This is
a file comment". We must now save this information. As stated above, we
could save explicitly or implicitly. This means we could select the "Save"
gadget now or some other feature, like "AppMenuItem" which will perform
a save and then place MIA on the Workbench menu bar under tools. Let’s
choose "Save". The MIA window now closes and all state information has
been saved. We can verify this by re-running MIA. Run MIA again and note
that it is exactly like we left it. "File Comment" is checked and our
comment is in the comment string gadget.

The next step is to use MIA to change a file’s comment. Close MIA’s window
first by selecting the window close gadget or the "Cancel" gadget. Now
double-click on your "Ram Disk". When the window opens, select
"Window>New Drawer" from the Workbench menu and then hit enter when the
"Rename" requester appears. You should now have a drawer named "Unnamed1"
in your Ram window. Click on the Unnamed1 drawer and then select
"Icons>Information..." from the Workbench menu. Note that there is NO
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comment listed in the comment string gadget for the Unnamed1 drawer.
Close the information requester. Arrange your windows so that both the
MIA icon and the Unnamed1 icon can be seen. Use extended selection to
run MIA on Unnamed1. You may want to consult your AmigaDOS user’s manual
to learn about extended selection, but this just means that you should
click once on MIA and then double-click on Unnamed1 while holding down
the shift key.

You should have seen your Ram disk window ’refresh’ its icons. (The
Unnamed1 icon automatically became UNselected.) Now use Workbench’s
information menu item to look at Unnamed1’s comment like we did previously.
It should say exactly what we wanted it to say: "This is a file comment".

While this may have been a ’long-winded’ explanation on how to use MIA,
you can see that MIA is quick and simple to use. For other ways to
have MIA alter icons, see the following:

Using MIA via Workbench

Using MIA via CLI
See

Examples
for step-by-step procedures using MIA.

1.45 MIA Examples

EXAMPLES

The following examples assume you are familiar with the basic operations
of MIA as explained in the

How to Use MIA
section. In particular,

you MUST be familiar with at least one method of activating MIA on an icon.
Whenever the following examples refer to altering files with MIA, you could
use any of these methods to do so:

Running MIA via Application Icon

Running MIA via Application Menu Item

Running MIA via Extended Selection

Using MIA via CLI
Examples using MIA:

Altering Default Tool



MIA 24 / 38

Altering File Attributes

Altering File Comment

Altering File Date

Altering Icon Imagery

Altering Icon Type

Altering Stack Size

Altering Tool Types

Making Default Icons

1.46 MIA Example Making Default Icons

EXAMPLE MAKING DEFAULT ICONS

In this example we will use MIA to create a default icon for drawers.

Open the Ram disk icon and note that no icons are visible (on a default system ←↩
).

Now select the "Window>Show>All Files" Workbench menu item. You should see
three drawers appear for "Clipboards", "ENV", and "T". Workbench has just ←↩

used
its default icon for drawers to show "virtual" icons for drawers that do not
have an associated icon of its own. Let’s replace this default drawer icon ←↩

with
one we create.

First close the Ram disk window. Now run MIA. Check the "Icon Type",
"Icon Imagery", and "Both Images" boxes. Now drag your "System:Prefs"
drawer over MIA’s selected image area (the one on the left) and drop it.
The Prefs drawer’s images should have appeared in MIA’s image areas.

Now that we have the icon set up the way we want it, let’s make it the
default. First specify which type the default will be for.
We want to make this the default drawer icon, so we click on MIA’s
"Type" cycle gadget until it displays "Drawer".

Now click on the "Make Default" button. MIA asks you to verify that you want
to make the current MIA icon the default drawer icon. Click on the
"Make Default" button in the "Modify a System Default Icon" requester. We ←↩

have
just replaced the system default drawer icon with our own. Let’s verify this.
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Quit MIA and then open the Ram disk icon. The same drawers are seen,
but now they look exactly like the "Prefs" drawer.

You can change defaults for all the icon types (Drawer, project, tool,
trashcan, and volume).

1.47 MIA Example Altering Tool Types

EXAMPLE ALTERING TOOL TYPES

This example shows you how to use MIA to alter Tool Types for icons.
Since MIA acts differently if the "Append T. Types" box is checked, there
are two examples: One with "Append T. Types" checked and one without.

For both of these examples, we will do the following: Copy
"System:Tools/Commodities/Blanker" and ".../ClickToFront" to Ram:. Note
that each has, among others, the two Tool Types "DONOTWAIT" and
"CX_PRIORITY=0". "DONOTWAIT" is used by the Workbench in the WBStartup
drawer. It tells Workbench not to wait for the program to quit before
starting the next program in the WBStartup drawer. The "CX_PRIORITY=0"
Tool Type is used by Commodities programs to specify the priority of the
Commodities programs.

The first example will show how to replace Tool Types. The second example
will show how to append (with replace) Tool Types.

WITHOUT APPEND TOOL TYPES

Suppose we do not like to see so many Tool Types in these two icons,
especially since most of them are defaults which do not even get used.
Further suppose that in fact, the only Tool Type we even want to use
is "DONOTWAIT".

First run MIA. Check the "Tool Types" and make sure that none of the
other boxes are checked (including "Append T. Types"). Now add a
new Tool Type by clicking "New" and then entering "DONOTWAIT".

Run MIA on the two icons. Use Workbench’s "Icons>Information..."
menu to verify that the only Tool Type in the two icons is DONOTWAIT.

WITH APPEND TOOL TYPES

For this example we will change the "CX_PRIORITY=0" Tool Type to
"CX_PRIORITY=1" for the two icons. (If you just tried the above
example, then make sure to reset everything back to the way it was
BEFORE trying the above example.) We may want to do this in order to
make these two Commodities be at a higher priority than the other ones.
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First note that each icon has a CX_PRIORITY value equal to 0. Now
run MIA and check the "Tool Types" and the "Append T. Types" check
boxes. Enter a new Tool Type, "CX_PRIORITY=1". Run MIA on the icons.

Use Workbench’s "Icons>Information..." to see that we left all the Tool
Types just as they were except for changing the value of CX_PRIORITY
from 0 to 1.

1.48 MIA Example Altering Stack Size

EXAMPLE ALTERING STACK SIZE

For this example we will change the stack size for project icons of
a tool. Remember that a project is generated by a tool. For example,
when you use the "System:Prefs/Palette" program and select the
"Project>Save as..." menu item, you have created a project (which will
be saved to the "System:Prefs/Presets" directory). Another example is
a word processor. The word processor is the tool and any document you
create is a project.

When you run a tool via a project (i.e. You ran your word processor by
clicking on one of your documents) the tool is run using the stack size
specified in the project icon and NOT the tool icon. This could
be a problem. Suppose you created a whole drawer of documents with
version 1.0 of your word processor. Soon you upgrade to version 2.0 of
your word processor. Say that this word processor has many new features
and requires a lot more memory to run. It is quite likely that your
new word processor requires a larger stack to run. If your new word
processor remains compatible you should be able to click on one of your
documents created with version 1.0 and have it run the 2.0 version of
the word processor to edit it. But if the stack size in your document’s
icon is too small, then your version 2.0 word processor could crash!

MIA to the rescue! Run MIA and check only the "Stack Size" check box.
Now enter a value in the "Stack" gadget. This value should be big enough
to allow your old documents to run with your new word processor. You may
get this number from the icon of a document created with version 2.0 of
your word processor. In fact, just drag and drop one of your documents
created with the version 2.0 word processor into the MIA "Stack" gadget
and MIA will enter its stack size into the gadget for you. Run MIA
on all the old documents. Now all of your old documents have large enough
stack sizes in their icons to allow your new version 2.0 word processor
to run without running out of stack.
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1.49 MIA Example Altering Icon Type

EXAMPLE ALTERING ICON TYPE

This example demonstrates one case where you might want to change the
type of an icon.

Suppose you have a program (i.e. a Tool) that allows you to update a
file’s date stamp to the current Amiga system date. You use this
program by clicking on it once, and then holding the shift key down while
you double-click on the files that you want to have updated. You like
this program a lot and decide to put it in one of your drawers. Soon you
decide you need it in other places also, so you make copies of the program
and move them to other drawers.

Now suppose you start running short on hard drive space. You start
looking for ways to save some disk space. You notice that you have
copied your favorite program to 11 of your directories and that the
program takes 20K of disk space. Hmm, if you could just keep only
one copy of your tool on your disk then you could save yourself
10 * 20K = 200K of disk space. But you want to be able to access your
tool from any of those directories.

MIA to the rescue! If you change 10 of those copies of your program from
tools to project icons, then you could solve this problem. Remember,
when you double-click on a project icon, Workbench runs whatever program
is listed in the icon’s ’Default Tool’ field. This means you could retain
one copy of the tool in one place on your disk and have all of the other
icons run that copy instead of having to have the program in each of your
directories.

All you have to do is run MIA and check only the "Default Tool" and
"Icon Type" boxes. Click on the "Type" cycle gadget until it reads
"Project". Now enter the path and name of the date stamp altering program
such as "Developer:Tools/Touch". Now run MIA on all the copies of
"Touch" (except for the one you are keeping in "Developer:Tools").

Voila! Now when you click on any of your "Touch" icons, you are running
the only copy placed in "Developer:Tools".

1.50 MIA Example Altering Icon Imagery

EXAMPLE ALTERING ICON IMAGERY

This example shows you how to change the images of icons. Since the
"Both Images" box affects how MIA handles images, there is an example
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with and without it checked.

WITH BOTH IMAGES

Suppose you are a programmer and you own an editor, X, that you
like to use because it is very powerful, but this editor produces only
one icon no matter what type of file you are creating. What you would
like is a to have a different icon produced for different files like
editor Y does. Editor Y creates an icon with a big ’C’ on it for
your ’.c’ source files, and icons with a big ’H’ on them for your ’.h’
header files, etc. You prefer editor X’s powerful features, but you
realy miss editor Y’s icons.

No more woes. MIA has a solution! With MIA you can change all of your
old source file icons created with editor X to look just like the icons
created by editor Y. To do so, run MIA and check only the "Icon Imagery"
and "Both Images" check boxes. Now drag and drop editor Y’s ’.c’ icon
on MIA’s selected image. (If you want to be different, you could hold
down the ’Alt’ key while you drop the icon. This will use the
alternate image when you drop. When in "Both Images" mode this
means to swap the selected and NON-selected images.) Now run MIA on all
your ’.c’ source files to make their images the same as in MIA.

WITHOUT BOTH IMAGES

Suppose you have a public domain disk with many programs on it. You
are trying to make it a bootable disk by copying the Workbench files to
it, but are a few kilobytes short of room.

Well, many of the PD programs have huge icons associated with them.
While they are interesting to look at (especially the ones that have
some sort of action picture like a closed eye that opens when you click
on it) they take up a lot of disk space. You decide that if you got rid
of a few icons, you would then have enough room to fit all of the
Workbench files. But if you deleted some icons, then you would have to
go to a CLI to run them or remember that they even exits so you could
use Workbench’s "Window>Show>All Files" menu item.

MIA provides a solution. Either you can draw a small icon with IconEdit,
or better yet, pick one from the PD disk. Run MIA and check only
the "Icon Imagery" button (make sure "Both Images" is NOT checked).
Now drop your small icon into MIA’s selected image area. (If you like
the alternate image of your icon better, then just hold down the "Alt"
key as you drop it over the selected image area.)

Since "Both Images" is off (note that the NON-selected image area has
an ’X’ across it), MIA will create icons that only have one image and
use "complement" highlighting instead of an alternate image. This will
save even more space on your floppy. Just run MIA on some of those
big icons and you now have more room on your floppy, and you still have
an icon associated with each program.
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1.51 MIA Example Altering File Date

EXAMPLE ALTERING FILE DATE

This example shows you how to alter file dates using MIA.

Suppose you like to keep a rigid date system for organizing and identifying
your files. You just used a DOS program to copy a bunch of files to a
directory that contains many other files. While you like the DOS
program, it does not maintain the dates properly. Now you have
to go in and set each specific file’s date to what you had intended. With
so many other files that you do not want to affect, it is difficult
to come up with an AmigaDOS pattern that will work with the "SetDate"
program to change only those files you just copied.

Yes, MIA can help! Run MIA and check only the "File Date" box. Enter
the date and time you desire in the "Date" and "Time" gadgets, or drop
an icon that contains the proper date and time in one of the gadgets.
Now use extended selection to alter only the files you need to.

1.52 MIA Example Altering File Comment

EXAMPLE ALTERING FILE COMMENT

This example shows how to change file comments with MIA.

Suppose you like to use file comments to keep files organized or
identified. Say you have a system where you set file comments to
"Released" after releasing your files into the public domain.
After ’releasing’ many files, it is cumbersome to change the comment
for each file.

Instead, use MIA. Run MIA and check only the "File Comment" box. Type
the comment "Released" into the "Comment" string gadget and then run
MIA on each of your files.

1.53 MIA Example Altering File Attributes
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EXAMPLE ALTERING FILE ATTRIBUTES

This example shows you how to set file attributes using MIA.

Suppose you have a large directory which contains some files that you
want to make read only. Unless you can determine an AmigaDOS file pattern,
each one will have to be manipulate individually -- or use MIA.

Run MIA and check only the "File Attributes" box. Now set the file
attributes the way you want, such as (---WED). Now run MIA on all the
files you want to have attributes updated.

1.54 MIA Example Altering Default Tool

EXAMPLE ALTERING DEFAULT TOOL

This example shows how to use MIA to change the default tools of icons.

Suppose you have been using editor Y to create all your ’C’ source files.
You buy a new editor, X, which you prefer to use whenever you edit any
of your ’C’ source files. In order to have editor X run whenever you
click on a source file icon, the icon’s default tool must be editor X.

Run MIA checking only the "Default Tool" box. Type the path and name into
the "Default Tool" gadget, such as "Work:Editors/X". Now run MIA on all
your source files. Now editor X will be used instead of editor Y.

1.55 MIA Using MIA via CLI

USING MIA VIA CLI

This section assumes you have read the
How to Use MIA
section and

are familiar with how MIA is generally used. The following sections
explain how to change MIA settings and actions, and how to use MIA from
a Command Line Interface (shell). See

Using MIA via Workbench
for ways

you can use MIA from a Workbench.



MIA 31 / 38

Changing MIA Settings

Changing MIA Actions
If you are familiar with AmigaDOS’s template feature, then ←↩

notice
that MIA’s template is similar to "Files/M,ALL/S". You may
want to consult your AmigaDOS user’s guide for more information about
templates if you are unfamiliar with them, but a brief explanation
follows. "Files/M" says that MIA accepts a listing of files as
arguments. For example, you could type "MIA Unnamed1 Unnamed2 Unnamed3"
at the shell prompt to have MIA alter the three files "Unnamed1",
"Unnamed2", and "Unnamed3". Note that the extension ".info" is
optional, and you can also specify a full path. For example, the
following is equivalent to the above (if the above was run from Ram:)
"MIA Ram:Unnamed1 Ram:Unnamed2.info Ram:Unnamed3.info".

MIA also understands AmigaDOS’s pattern matching facility. Please
see your AmigaDOS user’s manual for a full explanation of how to
use pattern matching. A quick example that will modify the same
files as above is "MIA Ram:Unnamed#?".

The "ALL/S" in the template above says that ’ALL’ is a switch that
can be specified on the command line. This switch has the same meaning
as the AmigaDOS ALL switch found on many commands like "Dir" and
"Delete". When ALL is given on the command line, MIA knows you want
to process all the files of any directory you told MIA to alter. For
example, "MIA System: ALL" will alter all the icons in System: and
all the icons in every directory below System: like System:Tools,
System:Utilities, etc.

WARNING: THE "ALL" OPTION MAY NOT WORK ON ALL DRIVES. Due to the
way that Workbench updates icons, how some filing systems update
their disks, and how MIA receives file names from AmigaDOS, it is
possible for MIA to get caught in an infinite loop. Currently, the only
filing system found to conflict in this manner is the one that operates
"Ram Disk". (NOTE: the "RAD" disk works just fine with MIA.) Since
no permanent data can be saved to Ram, it is unlikely that the above
mentioned limitation will interfere with the user’s need for MIA.

1.56 MIA Using MIA via Workbench

USING MIA VIA WORKBENCH

This section assumes you have read the
How to Use MIA
section and

are familiar with how MIA is generally used. The following sections
explain how to change MIA settings and actions, and how to use MIA by
extended selection, application icon, and application menu item. See
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Using MIA via CLI
for ways you can use MIA from a shell.

Changing MIA Settings

Changing MIA Actions

Running MIA via Extended Selection

Running MIA via Application Icon

Running MIA via Application Menu Item

1.57 MIA Changing MIA Settings

CHANGING MIA SETTINGS

MIA settings are the values to be copied to icons you are
altering. Settings are found on the left side of the MIA window and their
labels are white (when using the default Workbench palette).
Settings are ghosted until their respective action has been checked.
For example, you are NOT allowed to enter a new stack value until after
you click on the "Stack Size" action check box. Settings include the
following:

Type

Stack

Date

Time

Comment

Default Tool

Tool Types

Script

Archived

Readable

Writable

Executable

Deletable
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Selected Image

Non-Selected Image

1.58 MIA Changing MIA Actions

CHANGING MIA ACTIONS

MIA actions are what takes place when MIA is run on an icon. You control
MIA’s actions by checking off what you want MIA to do. Most of MIA’s
actions are controlled by the check boxes on the far right of the MIA
window. Actions have labels that are black (when using the default
Workbench palette). MIA actions can be separated into three groups. The
first group consists of the following ’Copy’ actions:

Default Tool

File Attributes

File Comment

File Date

Icon Imagery

Icon Type

Stack Size

Tool Types
This group describes what MIA will copy to icons that MIA ←↩

processes. If
the box is selected, then MIA will perform that action. If the box is NOT
selected, then MIA ignores that action. Note that this means it IS safe
to have settings typed into the gadgets on the left, but not have them
applied to the files being altered. MIA helps you know what is going to
change by using ’ghosting’. If any setting in the MIA window is ghosted,
then that setting will NOT be copied to the files being altered.

The next group of actions modify some of the previous actions. They
consist of the following:

Append T. Types

Both Images

Create Icons
If one of the above check boxes are checked, then the meaning ←↩

of other
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actions may be sightly different. For example, if you have the
"Icon Imagery" action selected above, then you want to change the images
of icons. When making these changes, MIA will look to see if the
"Both Images" modifier check box is checked or not. If the box IS checked
then MIA knows to replace BOTH of the icon’s images with the images last
saved in the MIA window. If the "Both Images" button is NOT checked, then
MIA knows that you only want to replace the selected image of icons.

The final group consists of the following actions:

AppIcon

AppMenuItem

About MIA

Make Default

Save

Cancel
The above actions specify actions that do not fit in the other ←↩

two groups.
They control how you want to use MIA, provide information about MIA,
allow you to replace system default icons, save the current MIA state, or
cancel MIA.

1.59 MIA Running MIA via Extended Selection

RUNNING MIA VIA EXTENDED SELECTION

Open the MIA window by double-clicking on the MIA icon. This allows
you to make setting and action changes to MIA. Once MIA’s state is the
way you want it, change the icons by using extended selection.
Consult your Workbench user’s guide to learn about how to use extended
selection. All you really have to do is select MIA by clicking on it
once. Now hold down the shift key and click once on every file you want
MIA to change. You may also use drag selection while you hold down the
shift key. Drag selection means you press and hold the left mouse button
down while you make a box around the icons you want to select. Workbench
will display a moving outline of a box while you are drag selecting in
order to help you make sure you select only the icons you want. Once you
have selected all the files you want to change, just double-click on
one of the selected files. Workbench will run MIA on each of the files
you selected. Watch as Workbench updates each icon that MIA alters.

Extended selection may be difficult to learn for the first time, so let’s
do a quick example. Open up your "Ram Disk" and create three new drawers
by using Workbench’s "Window>New Drawer" command. Leave the names of
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the drawers just like Workbench gives them to you by hitting return
in the "Rename" requester. You should now have three drawers in your
Ram window named "Unnamed1", "Unnamed2", and "Unnamed3".

Run the MIA program by double-clicking on its icon. Select the "File
Attributes" check box. The file attribute buttons should become UNghosted
and thus changable. Remove the check from the "Deletable" check
box by selecting it. We have told MIA that we want to change file
attributes to look just like we have them set up. (A check means we
want the bit set and no check mark means we want the bit NOT set.) You
can see that we will be altering files so that they are no longer deletable.

Save the MIA state by clicking on the "Save" gadget. The MIA window now
disappears and the MIA state has been saved for later use. Now look at
the drawers created in Ram. By using Workbench’s "Icon>Information..."
menu item we can see that each drawer IS deletable. (We know this because
we can see that there is a check mark beside "Deletable" in the
"Information" requester.) Now close the information window(s) and
alter those drawers using MIA and extended selection.

Click on MIA once. Continuously hold down the shift key an go to the
Ram window and click the left mouse button in the Ram window and hold it
down while you drag over two of the drawers. Now release the mouse
button, but do not let up the shift key. Two of the drawers should be
selected. Now select the third drawer and activate MIA in one step.
While holding down the shift key, double-click on the last drawer.
Notice that each drawer becomes UNselected. MIA has changed these
drawers to NON-deletable.

Let’s verify this is true by using Workbench’s information menu item. You
can see that the "Deletable" check box for the drawers are NO longer
checked. We have successfully made these drawers protected from deletion.
Try it! Select one of the drawers and then select Workbench’s
"Icons>Delete..." menu item. After selecting "OK" to verify to Workbench
that you want to delete this drawer, Workbench tries to delete it.
Notice that it fails and Workbench displays a message similar to
"Error while removing Unnamed3: (222) object is protected from deletion".

1.60 MIA Running MIA via Application Icon

RUNNING MIA VIA APPLICATION ICON

You can turn MIA into an Application Icon which means that an icon
appears on the Workbench screen (like your "System" and "Ram Disk"
icons) that represents the MIA program. Turn MIA into an Application
Icon by clicking on the "AppIcon" button in the MIA window. This saves
the current MIA sate and then puts the MIA icon on the Workbench screen.
(You may change the appearance of this icon if you like by altering the
file in ENVARC:MIA and ENV:MIA that is called "def AppIcon". You can
change the image, but do NOT change the name of the icon.) While MIA
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is an Application Icon, you have two choices: 1) Drag and drop some
files on the MIA application icon or 2) Double-click on the MIA
application icon.

If you drop some files on the MIA application icon, then MIA will alter
these files according to MIA’s current state. Consult your Workbench
user’s guide to learn various ways to drop icons onto an Application
Icon. You can select and drop a single icon or you can select and drop
groups of icons by using extended selection and drag selection. After
dropping some icons onto the MIA application icon, you may see Workbench
updating each icon as MIA changes it.

By double-clicking on the MIA application icon, the MIA window
will appear allowing you to make settings and action changes. You may
also choose to remove the MIA application icon from Workbench’s screen
by selecting the close gadget at this point, or making MIA an

Application Menu Item
by selecting the "AppMenuItem" button.

1.61 MIA Running MIA via Application Menu Item

RUNNING MIA VIA APPLICATION MENU ITEM

MIA can be turned into an Application Menu Item which means that you can
see MIA on your Workbench menus. Make MIA an Application Menu Item by
clicking on the "AppMenuItem" button in the MIA window. This saves the
current MIA state and then puts "MIA" under Workbench’s "Tools" menu.
While MIA is an Application Menu Item, you have two choices: 1) Select
some files and then pick the "Tools>MIA" menu item or 2) Do NOT select
any files and then pick the "Tools>MIA" menu item.

If you have NOT selected any files, then the MIA window will reappear
allowing you to modify MIA settings and actions. You may also choose
to remove MIA from the Workbench menu by selecting the close gadget at this
point, or making MIA an

Application Icon
by selecting the "AppIcon" button.

If you DO select some files, then MIA will modify them according to MIA’s
current state. You may want to consult your Workbench user’s guide to
learn various ways to select gadgets. You can select a single icon or
you can select groups of icons by using extended selection and drag
selection. Once you have selected some icons, select the "MIA"
menu item and watch them get updated!
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1.62 MIA Registering MIA

REGISTERING MIA

MIA is "Shareware". This means you can make copies of MIA and give it
to your friends and transfer it on Bulletin Board Systems, etc. If you
(or your friends) like MIA and continue to use it for more than just
a "trial-period" then you are obligated to send a donation to its
creator.

Besides being the "nice-thing-to-do", by sending in your contribution
you are registering yourself to the creator of MIA. This entitles you
to some benefits. Your benefits include:

- Being added to the MIA database. This insures you of being notified
of changes and updates to MIA, new product releases, etc.

- You may receive discounts to commercial products that MIA’s creator
is involved with.

- You help insure that shareware writers will continue to produce top
quality products at minimal prices, for you!

***** Your most immediate concern: YOU WILL RECEIVE THE FULL WORKING
VERSION OF MIA WITH ABSOLUTELY ALL FEATURES ENABLED!

The suggested/requested contribution is $10 American currency. This
fee INCLUDES shipping charges. (Some of the money is used to pay for
disk, label, postage, etc.)

You may register by E-Mail or regular postage. Please fill out the
following form and send it to:

By Electronic Mail

"BoydXNebula" on the Byte Information eXchange (BIX)
(which you can reach via Internet address "BoydXNebula@BIX.COM")

-- OR --

By Postal Service

Boyd Edmondson
1318 Mill Creek Blvd. #R204
Mill Creek, WA 98012
USA

It is recommended that you type the following form to make sure there
is no mistake in shipping to you.
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------------------------->8 CUT HERE 8<-------------------------

PRODUCT REGISTERING: Mass Icon Alter

NAME:
ADDRESS:

CITY:
STATE:
ZIP:
COUNTRY:
PHONE:
COMMENTS:

------------------------->8 CUT HERE 8<-------------------------
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